Importing Part Information in Sage BusinessWorks 2013
Sage BusinessWorks Accounting import format requirements:
1. The import file must be in a comma delimited variable (.CSV) text format. Each field can contain only standard
ASCII characters, separated by commas. The file should resemble the examples at the end of this document.
2. Only those fields listed on the following page can be imported into Sage BusinessWorks, and they must be
imported in the order shown.
3. Each record in the file must be terminated by a carriage return and line feed.

Before you begin the import process:
1. Always back up your company data prior to importing a file.
2. Do not delete the import file from your system’s memory until you are satisfied with the results of the import.

Time-saver: Defining product lines and using model parts
Sage BusinessWorks provides two means, product lines and model parts, by which default information can be added to
all new parts being imported. Because the defaults for product lines override the defaults for the model part, use one or
the other, but not both.
1. Define product lines (Utilities / Maintain Product Lines). Define product lines prior to importing and then include a
product line ID in each part’s import record (see Table 3). Sage BusinessWorks adds the following information to all
new parts being imported, which include a product line ID in the import record:
Measurement / Quantity
Inventory Item?
Unit of Measure
Fractional Quantity?
Backorders OK?
UPS Shippable

Cost / Price
Pricing Method
Discount?
Taxable?

Table 1: Defaults imported from the Product Line
2. Create a model part (Parts / Maintain Parts). Then specify that part as the model part on the Import Part Information
screen. This information is added to all new parts being imported:
Measurement / Quantity
Unit of Measure
Fractional Quantity?
Backorders OK?
UPS Shippable

Cost / Price
Pricing Method
Discount?
Taxable?
Fractional Cost / Price

Misc. Information
Product Line
Product Categories
Primary Vendor ID
Bin / Location
Main Warehouse ID

Table 2: Defaults imported from a Model Part
Important notes:



If a product line is included in the import record, defaults shown in (Table 1), above, are taken from that product line,
rather than any model part specified during the import (Table 2).
If no product line is specified either in the import record or by using a model part, Sage BusinessWorks assigns the
part to the Standard product line.
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Importing Part Information

Importing Part Information (continued)

Importing fractional quantities, costs or prices:
1. In Utilities / Maintain I/C Parameters, specify the number of decimal places for costs and prices.
2. Use a model part that has the "Fractional Qty" and "Fractional Cost/Price" check boxes selected. (Do not specify a
product line in the import records.)
Note: Sage BusinessWorks interprets any decimal value (even .00) as a fractional quantity; values with three or more
decimals (.0000) are interpreted as a fractional cost or price. If the above parameters are not set and the
quantities have decimal values, the fields will fail to import.
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Importing Part Information (continued)

Sage BusinessWorks Part import format
Field

Max
1
Length

Valid Entries / Format

N/A

Add:
/A or /ADD
Update: /U or /UPDATE
Rename: /R or /RENAME

3

20

Any text. (Lowercase letters will be converted to uppercase during import.)

3

28

Any text.

0

Transaction Type

1

Part Number

2

Delete: /D or /DELETE
Change: /C or /CHANGE

2

Description 1

3

Description 2

28

Any text.

4

Description 3

28

Any text.

5

Unit of Measure

4

Any text.

6

Bin/Location

10

Any text.

7

Manufacturer’s Part #

20

Any text. Vendor ID (next field) must exist in Accounts Payable.

8

Vendor ID

12

Any vendor ID that exists in Accounts Payable. (Lowercase letters are
converted to uppercase during import.)

9

Product Line ID

8

Any existing product line ID. (Pre-define in Utilities / Maintain Product Lines.)

10

On Hand Quantity

11
7

If Fractional Quantities is enabled: 0.000 - 9,999,999.000
5
If Fractional Quantities is disabled: 0 - 9,999,999

11

Unit Cost

9

If Fractional Cost/Price is enabled: $0.00 - $9,999.9999
5
If Fractional Cost/Price is disabled: $0.00 - $999,999.99

12

Base Price

9

If Fractional Cost/Price is enabled: $0.00 - $9,999.9999
5
If Fractional Cost/Price is disabled: $0.00 - $999,999.99

13

Main Warehouse ID

12

Warehouse ID must already exist in Sage BusinessWorks. (Also, see using a
model part to import the main warehouse ID.)

14

Price 1

9

Up to 25 price levels can be imported (v5 and later).

…

…

38

Price 25

4

4

5

5

5

39

6

…
6

Long Description

9

1000

For the Absolute pricing method:
5
If Fractional Cost/Price is enabled: $0.00 - $9,999.9999
5
If Fractional Cost/Price is disabled: $0.00 - $999,999.99
5
For the Markup and Base pricing methods: 0.000% - 999.999%
5
For the Margin pricing method: 0.000% - 100.000%
Any text except carriage return/line feed. Replace carriage return/line feeds
with '\n' in the long description field of the import file. During import, '\n' is
changed back to carriage return/line feed. Data longer than 1000 characters is
truncated to 1000.

Table 3: Importing Part Information
1

If the length of a field exceeds the maximum number of characters allowed for importing, Sage BusinessWorks
automatically truncates it to the maximum number allowed.

2

If adding a new part, no prefix is required. If /U is used, Sage BusinessWorks updates an existing part or adds a new
one if that part ID does not exist. /C changes existing parts only. /D deletes a part only if the part has no historical
transactions currently on file and the on-hand quantity is 0.00. (See the Parts / Maintain Parts option.)

3

Required fields when adding a new part. (When deleting parts, use the transaction type “/Delete” and part ID only.)

4

On Hand Quantity and Unit Cost can be imported only if (1) I/C is in setup mode, (2) the on-hand quantity is zero, and
(3) there have been no transactions for the part.

5

Only positive values can be imported in these fields. Negative values are converted to zero. Do not enter commas,
dollar signs or percent signs in import records. (They are used here for clarity only.) To import fractional values, import
using a model part that has “Fractional Quantity” and/or “Fractional Cost/Price” enabled.

6

Prices can be imported for the first quantity range for only those parts that use a pricing method other than Line.
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Importing Part Information (continued)

Part import examples
The following are examples of import records. Note that <cr> and <lf> represent carriage-return and line-feed,
respectively.
1. Adding a record. Sage BusinessWorks adds a new record only if the Part ID does not already exist. (The three
examples below are identical in function.)
HELMET,“Racing Helmet, Blue”,,,each, Bin Location #1,102-4ac,JONES,STANDARD,10,25.00,40.00,,
40.00,60.00,80.00<cr><lf>
/ADD, HELMET,“Racing Helmet, Blue”,,,each, Bin Location #1,102-4ac,JONES,STANDARD,10,25.00,
40.00,,40.00,60.00,80.00<cr><lf>
/A, HELMET,“Racing Helmet, Blue”,,,each, Bin Location #1,102-4ac,JONES,STANDARD,10,25.00,
40.00,,40.00,60.00,80.00<cr><lf>

Notice the extra commas after the first description line in these records. Commas are used as “place holders” to
tell Sage BusinessWorks that a field is to be left blank (or unchanged in the case of an update). In these
examples, a placeholder is used for fields 3 and 4, Description 2 and Description 3. Without these commas, Sage
BusinessWorks would import “each” as Description 2, “Bin Location #1” as Description 3, etc.


Description 1 is enclosed in quotation marks because it contains a comma. Without the quotation marks, Sage
BusinessWorks would attempt to import “Blue” into Description 2, blank for the Description 3 and Unit of Measure
fields, “each” for Bin/Location, and so on.

2. Updating a record. If the part ID, CUSTOM, already exists in this company, Sage BusinessWorks updates that part
with information from this import record. If this part doesn’t exist in this company, Sage BusinessWorks adds it.
/UPDATE,CUSTOM,Custom Bike,,,each,Bin Location #2,,,,1,150,300<cr><lf>
3. Changing a record. If the /C or /CHANGE parameter is used, Sage BusinessWorks changes a record that already
exists in the company with this ID. In this example, if the part ID “SHORTS” exists, Sage BusinessWorks updates the
base price. Otherwise, the record is ignored during the import process.
/C, SHORTS,,,,,,,,,,,25.00<cr><lf>
4. Deleting a record. Enter the “deleting” prefix followed by the ID to delete. If there are no historical transactions for the
part and the on-hand quantity is 0.00, Sage BusinessWorks deletes the record. The period of time Sage
BusinessWorks saves historical data is set in the Utilities / Maintain I/C Parameters option.
/DELETE,SHORTS<cr><lf>
5. Renaming a record. Enter the “renaming” prefix, original ID, and new ID. In the record below, the part ID “SHORTS”
is changed to “SHORTS-BLUE”
/RENAME,SHORTS,SHORTS-BLUE<cr><lf>
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Importing Part Information (continued)

Creating a sample file to review in Sage BusinessWorks
To examine a sample part data import file, follow the steps below to create a file from the Sage BusinessWorks Sample
data using the data transfer options.
1. Create an outline: Select Inventory Control /Transfer / Custom Exports, click New and assign a name to the export
format.
2. Select the IC Part Pricing (All) data source and select the following fields:
Items to be exported:
1:
<icpart> ID
2:
<icpart> Description1
3:
<icpart> Description2
4:
<icpart> Description3
5:
<icpart> UnitOfMeasure
6:
<icpart> BinLocation
7:
<icpart> Vend_MFGPartID
8:
<apvendor> ID
9:
<icpartprice_view> ProductLineID
10:
<icpart> OnHandQty
11:
<icpart> PartCost
12:
<icpart> BasePrice
13:
<icpart> MainWarehouseNo
14:
<icpartactual> Price1_ActAmt1
15:
<icpartactual> Price1_ActAmt2
16:
<icpartactual> Price1_ActAmt3
17:
<icpartactual> Price1_ActAmt4
18:
<icpartactual> Price1_ActAmt5
19:
<icpartactual> Price1_ActAmt6
20:
<icpartactual> Price1_ActAmt7
21:
<icpartactual> Price1_ActAmt8
22:
<icpartactual> Price1_ActAmt9
23:
<icpartactual> Price1_ActAmt10
24:
<icpartactual> Price1_ActAmt11
25:
<icpartactual> Price1_ActAmt12
26:
<icpartactual> Price1_ActAmt13
27:
<icpartactual> Price1_ActAmt14
28:
<icpartactual> Price1_ActAmt15
29:
<icpartactual> Price1_ActAmt16
30:
<icpartactual> Price1_ActAmt17
31:
<icpartactual> Price1_ActAmt18
32:
<icpartactual> Price1_ActAmt19
33:
<icpartactual> Price1_ActAmt20
34:
<icpartactual> Price1_ActAmt21
35:
<icpartactual> Price1_ActAmt22
36:
<icpartactual> Price1_ActAmt23
37:
<icpartactual> Price1_ActAmt24
38:
<icpartactual> Price1_ActAmt25
39:
<icpart> LongDescription
3. Click Next on the Set Sort By and Set Filters windows, then click Done.
4. Click the Export button and select “Comma-Delimited Text (CSV)” from the drop-down list.
5. Select the “View on Screen” radio button and click OK. The file displays in Excel.
6. In Excel, delete any header rows. (To delete a row or column, click its label, then right-click the mouse and select
Delete.)
7. Select Save as from the File menu and browse to the location to store the file. (Leave the “Save as type” selection set
to “CSV (Comma delimited) (*.csv)”.)
If you have successfully completed these steps, the file created contains part information that can be imported into Sage
BusinessWorks. Examine this file using the Windows Notepad to become familiar with the required format for importing
part information into Sage BusinessWorks.
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Importing Part Information (continued)

Importing prices...
When importing prices, whether for a new part or for updating an existing part, be certain that the pricing method for the
part is not Line. (The Line pricing method means that Sage BusinessWorks calculates the price based on the method
defined for the product line to which the part is assigned. It would, therefore, not be logical to import part prices under this
pricing method.) To determine the pricing method assigned to a part, go to Parts / Maintain Parts; then go to the Pricing…
page. Important points to keep in mind:

Whether importing prices for either a new or existing part, don’t specify a product line on the import record. (Use a
comma as a placeholder for the product line field.) If a product line ID is included in the import record, Sage
BusinessWorks sets the pricing method for the part to Line and ignores prices.


If you are importing a new part, use a model part that has a pricing method other than Line. If no model part is used,
Sage BusinessWorks automatically assigns the Line pricing method to the part and ignores any prices specified.

Exporting parts from one Sage BusinessWorks company to import into another...
When exporting data from an existing Sage BusinessWorks company, Sage BusinessWorks automatically exports the on
hand quantity as a decimal value. In order to import the on hand quantity into a new company, the new company must be
in SETUP mode and you must do one of the following:

When importing data into the new company, create a model part and select the Fractional Qty check box. Specify this
model part on the Transfer / Import Part Information window.
All parts imported into the new company are automatically set to allow fractional receipts, issues, adjustments, and
invoices and will show the quantity with decimal values. If this is not acceptable in this company, please use the
alternative below.

- OR 

Export the data to an Excel spreadsheet and modify the format of the on hand quantity column. Here’s how:
1. In the Sage BusinessWorks Transfer / Export Part Information / Export File Selection window, select the version
of Excel you are using as the Data Format.
2. Note the file name and path, and click OK to export the part information.
3. Open the file in Excel and click the column letter at the top of the on hand quantity column (Generally, the on
hand quantity would be in column “K”.
4. From the Format menu, select Cells.
5. In the Category column, select “Currency”. Set Decimal places to zero and Symbol to “None”. Click OK. The
column should now be stripped of all decimals.
6. From the File menu, select Save As. Click the down arrow for Save as type: and select “CSV (Comma delimited)
(*.csv)”.
7. Import the file saved in Excel into Sage BusinessWorks.

Notes:
 The Fractional qty parameter corresponds to the setting for the Product Line, if the Product line is specified in the
import file; otherwise the parameter is set by the model part. (If neither a product line nor model part is specified,
the part is assigned to the STANDARD product line and the Fractional qty parameter corresponds to the setting
for that product line.)


Only positive on hand quantities can be imported. A negative on hand quantity imports as zero.
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